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Glass Eye 2000 Professional Plus is a highly spe-
cialized creative environment for designing stained 
glass patterns (FIG. 1). It provides expert tools, ma-
terials, patterns, and functions that are not found in 
mainstream drawing or illustration programs, such 
as Adobe Illustrator or CorelDraw.  Glass Eye 2000 
is, simply, the best-in-class application for stained 
glass design and pattern-making.

Included with the program is a 400-file pattern li-
brary in ready-to-use form. In addition, more pat-
terns are available for sale on the publisher’s web-
site, http://www.dfly.com, following the “Patterns 
for Sale” link (FIG. 2). Any of these patterns can be 
customized in any variety of ways to express the 
exact design intent of the user.

©2013, Graphic Dimensions, Boynton Beach, FL. All Rights Reserved.

FIG. 2. The Glass Eye 2000 store sells hundreds of unique stained glass patterns.

FIG. 1.  The Glass Eye 2000 work environment provides all of the tools and stained glass specific functions necessary for design and fulfillment.
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All stained glass patterns, from simple to complex, 
are composed of any or all of the following: curved 
or straight lines, and circles or ellipses. The program 
utilizes an elegantly simple system to define curves 
and to build-out a design from any point. The points 
that define a curve are called “knots,” and moving 
the knots changes the fit of the curve between any 
two outlying knots (FIG. 3). There are two kinds of 
knots; one that delineates the shape of the line, and 
a second, called a “slider,” that moves with a line as 
the shape of that line changes. On-screen a slider 
knot is designated as a white dot, whereas fixed 
knots appear as gray. 

Connecting any two knots forms a straight line. Add-
ing a knot anywhere along a straight line enables the 
formation of a curve. When knots and lines form an 
enclosed space it is referred to as a “piece.” Piec-
es can be filled with colors that will ultimately be 
used to create the actual stained glass item (FIG. 4). 
The colors can be turned off by pressing the Show 
Colors button, so that they do not distract from 
the pattern. The shapes that form the design can be 
manipulated in an infinite variety of ways, providing 
an artistic palette with endless choices. In addition 
to the design itself, the size of the output can be 
scaled, in inches, feet, millimeters, centimeters, and 
meters, and resized to any dimensions.

The program environment is arranged in typical 
fashion, with the commands subsumed in the menu 
bar, the toolbar below it with the array of tools, 
the color palette along the left edge, and the main 
design viewing area occupying the remainder of the 
screen. Rulers can be displayed along the top and 
left side of the viewing area, and the origin point can 
be reset for convenience.

The finished output from the program is in the form 
of printed sheets. The user can output a design on a 
single sheet, regardless of its actual size; in its actual 
size, which may require tiling across multiple sheets 
of paper; or scaled by a specific percentage. In addi-
tion, the output may be page-numbered, include the 
title and artist, the date and time, and the filename. 
The Reverse Design option can be used to print a 
mirror image of the design to view it from the back 
rather than the front (FIG. 5). The output options 
also include a Calibrate function to ensure that any 
inaccuracies in the printer hardware, or software 
driver, are adequately compensated for. And finally, 
a Print Preview is provided to check the design on-

FIG. 3.  Knots appear as small round dots.

FIG. 4.  Pieces are contained areas.   

FIG. 5.  The Page Setup dialog box.  
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screen before committing it to paper.

Navigating a design that is partially out of the field 
of on-screen view is accomplished either by us-
ing the scroll bars on the right side and bottom 
of the work area, or by using the Pan tool to grab 
an area and move it anywhere within the confines 
of the screen. The Magnifying tool can also be used 
to zoom in or out to show extreme detail or size 
reduction. 

Editing elements in a design can be accomplished in 
many ways. A single line segment, or multiple seg-
ments can be moved, reshaped, or deleted. Move-
ment can be restricted to horizontal, vertical or di-
agonal by holding down the Shift key while dragging. 
Movement can also be accomplished by using the 
arrow keys. Holding down the Control key while 
using the arrow keys results in precision movement. 
Regardless of what editing actions have taken place, 
the user has multiple levels of Undo and Redo to 
reclaim past work.

The lines in a design represent lead that will hold 
the pieces of stained glass together. Each line has a 
face width, which is the visible leaden line that will 
ultimately appear on the finished piece. A portion 
of the lead that flows between the adjoining pieces 
is called the heart thickness. The user can set these 
values, in inches or millimeters, using the Default 
Line Properties selection from the Modify menu 
(FIG. 6). Precise measurements can be executed by 
enabling the Show Measurements option from the 
shortcut menu. Users then get real-time read-outs 
of elements as they are drawn.

As previously stated, all designs are composed of 
various iterations of lines and curves which are 
joined to form pieces that are ultimately cut out of 
glass. A straight line is formed by using the Curve 
tool, clicking in the start position, dragging the 
length of the line, and then double-clicking. To sim-
plify the construction of common shapes the user 
can select from the Draw menu to create curves, 
arcs, squares, rectangles, circles, ellipses, and poly-
gons. The Drawing Properties selection, also in the 
Draw menu, provides options for settings such as 
the starting position of a square (center or corner), 
the number of sides in a polygon, and more. 

Color, either solid, textured, or images of actual 
glass surfaces, can be added at any time to a com-

FIG. 6. The Line Properties dialog box.  
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pleted piece. Color mode is entered by clicking on 
one of the colors in the palette. The cursor then be-
comes a tipping paint bucket that releases its color 
contents when clicked in a defined area. Changing 
colors of multiple like-colored pieces can be ac-
complished easily by selecting a replacement color, 
holding the right mouse button, and clicking in any 
of the target pieces. They will all change at the same 
time. A color may be removed by clicking on the 
top color palette button, which is blank, and clicking 
on the color to be removed. 

Adding a new color to a color palette button is ac-
complished by double-clicking the button, which re-
sults in the display of the Color Selector dialog box. 
Here the user can select any color, either visually or 
numerically, select the texture, and the actual glass, 
by manufacturer, that most closely approximates its 
appearance (FIG. 7). These options, and more, such 
as setting the glass opacity and angle, enable the 
user to produce the most accurate rendering of the 
finished piece possible.

Control over knots, which form the start and end of 
a line, determine the arc of a curve and the shape of 
a piece, is a fundamental skill in Glass Eye 2000. The 
essential rule regarding knots is that the fewer the 
number of knots on a line, the smoother the line 
will be, and, the more knots on the line, the more 
control the user will have over its shape. With this 
in mind, the user is significantly empowered with 
the options to add or remove knots, move them 
along a line, or add them uniformly to subdivide a 
line segment or shape.

The lines and knots that form a pattern can be edit-
ed in an infinite variety of ways, using typical drawing 
program commands such as cut, copy, paste, stretch, 
resize, rotate, move, scale, flip, reflect, straighten, 
group and repeat. The Yank command is unique in 
that it enables separating a line from a knot so that 
it can be positioned elsewhere. 

The precision of the design process is aided by a 
number of on-screen features that help to guide 
the user’s placement of pattern elements. The first 
of these are the Crosshairs, two repositionable 
perpendicular or diagonal lines that can be placed, 
where necessary, for exact alignment. The second 
are Grid lines, which form independent, equally 
spaced horizontal and vertical lines, in any user-de-
fined increments, with an optional Auto Grid Snap 

FIG. 7.  The Color Selection dialog box.  
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feature that ensures symmetry. As with other fea-
ture properties, there are a variety of settings that 
can be applied to both Crosshairs and Grids.

One of the most difficult stained glass patterns to 
construct is a panel lampshade. The program’s Lamp 
Wizard greatly simplifies the process with a dialog 
box with user-defined settings for the number of 
sides, number of tiers, tier measurements, and more 
(FIG. 8).

Although there is significant precision programmed 
into Glass Eye 2000, users can still make mistakes, 
such as failing to have knots at the intersection of 
two lines. Fortunately, the program has the intelli-
gence to detect such problems by using the Suggest 
option from the Help menu. The Suggest command 
can identify missing knots, overlapping lines, uncol-
ored pieces, and more.

Keeping track of many individual pieces that will 
compose a stained glass project is a daunting prob-
lem which is addressed with the program’s available 
text and labeling options. The Add Text button en-
ables the composition of any text, in any available 
font, size, and color, to be placed anywhere on the 
screen. Individual pieces can be numbered automat-
ically using the Piece Labeling option from the Text 
menu. The numbers can be assigned by piece color 
(consecutively) or location (top to bottom), using a 
user-defined font for normal and small pieces (FIG. 
9). The color of each piece can also be indicated by 
defining it in the Color Selector. This information 
is vital for keeping track of each piece during pro-
duction.

Although text is not usually a part of a stained glass 
design, it can be. Glass Eye 2000 can convert the 
outline of any text into its corresponding shape 
using the AutoTrace Text command. The resulting 
shape(s) can be filled with glass color(s), and edited 
like any other shape.

The versatility of Glass Eye 2000 is quite impressive. 
Designs from other sources, such as raster or vec-
tor files, digital photos, or scanned images can be 
imported as background images that can, based on 
their properties, be traced either manually or auto-
matically. Vector files from Adobe Illustrator, Corel-
Draw and AutoCAD in WMF, EMF, DXF, or DWG 
format can be imported directly. The program can 
export files as BMP, JPEG, TIFF, PNG, PCX, WMF, 

FIG. 8.  The Lamp Wizard dialog box.  

FIG. 9.  The Piece Labeling dialog box.  
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EMF, and DXF formats. Selected portions of a de-
sign can also be exported, and as with the complete 
design, can be sent directly to a client via e-mail.

Completed designs are saved, either manually or 
using the AutoSave command, wherein the user can 
specify a recurring interval, and then printed. 

As a professional program, which may be used on 
a daily- if not hourly-basis, Glass Eye 2000 provides 
significant user customization options. The user can 
make their own shortcut menus, and assign hot keys 
to frequently used commands, using the Customize 
Menus and Hot Keys from the View menu (FIG. 10).  

Glass Eye 2000 goes far beyond the confines of a 
pure design environment. Using the Design Prop-
erties dialog box the user can define the project 
metadata, including title; artist; style; category; shape; 
keywords; degree of difficulty; notes; glass, copper 
foil, and came usage; scrap factor; calculated mate-
rial cost; miscellaneous item cost; labor cost; profit 
percentage; and calculated project cost. 

In the realm of stained glass pattern making, Glass 
Eye 2000 stands at the pinnacle of the craft of com-
puter-aided design. Not only is it elegantly pro-
grammed to cover virtually every design contingen-
cy, but is also thoroughly documented. The full guide 
can viewed on-line at:
http://www.dfly.com/tutorial/index.html,
or downloaded as a PDF at:
http://www.dfly.com/tutorial/getutorial.pdf. 
A 10-min. video demonstration can be viewed 
at: 
http://www.dfly.com/video.html. 
Prices range from $150 for the Standard hobby-
ist version, to $1295 for the Enter-prise version. 
Most of the features described in this review are 
available in the Professional Plus version costing 
$450. A comparison of the various editions can be 
seen at http://www.dfly.com/editions.html. A 30-day 
trial version of the software can be downloaded at 
http://www.dfly.com/download.html.

Dragonfly Software, 1158 North Fairview Ave.,
Goleta, CA 93117, (800) 553-7246, Fax: (888)
463-8817, http://www.dfly.com, e-mail:
support@dfly.com.

FIG. 10.  The Customize Menus and Hot Keys dialog box.  
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